Before using the instrument, be sure to read this manual thoroughly. Keep the manual where it is easily accessible.
PLEASE NOTE

1. Reading of image and storage of data must be performed in accordance with the law of the country where the product is being used. Also, the user is responsible for maintaining the privacy of image data.
2. In no event will Canon be liable for direct or indirect consequential damage arising out of the use of this product. Canon will not be liable for loss of image data due to any reason.
3. Please read the software license agreement before installing this product on the computer.
4. Please ask the distributor or Canon representative where you made the purchase to install this product.
5. Canon reserves the right to change the specifications of the product without prior notice.

• Microsoft, Windows, the Windows logo, and ActiveX are registered trademarks or trademarks of Microsoft Corporation USA and other countries.
• The Microsoft Internet Explorer logo is a trademark of Microsoft Corporation USA and other countries.
• This software is based in part on the work of the Independent JPEG Group.
• Other systems and product names in this manual are the trademarks of each manufacturer that developed them.

© CANON INC. 2008

All rights reserved.
Under copyright laws, this manual may not be copied, in whole or in part, without the written consent of Canon.
3.10.2 Changing the password ................................................................. 66
3.10.3 Log Reference .............................................................................. 67

4. Storage Administrator ....................................................................... 71
  4.1 Storage Administrator Window ...................................................... 71
    4.1.1 Opening the Storage Administrator window ................................. 71
    4.1.2 Closing the Storage Administrator window .................................... 72
  4.2 Setting the online folder .................................................................. 73
    4.2.1 Adding online folders ................................................................... 73
    4.2.2 Changing online folder settings .................................................... 75
    4.2.3 Changing online folders ............................................................... 77
    4.2.4 Deleting online folders ............................................................... 78
  4.3 Setting the backup folder ................................................................. 79

5. Receiving Images (DICOM-Protocol Image Receiver) ..................... 81
  5.1 What is the DICOM-Protocol Image Receiver? ................................. 81
  5.2 DICOM-Protocol Image Receiver window ........................................ 82
    5.2.1 Opening the DICOM-Protocol Image Receiver window .................. 82
    5.2.2 Closing the DICOM-Protocol Image Receiver window .................... 83
    5.2.3 Quitting the DICOM-Protocol Image Receiver ................................ 83
  5.3 Starting and stopping the Receiver Service ..................................... 84
    5.3.1 Starting receiver service ............................................................. 84
    5.3.2 Stopping receiver service ......................................................... 84
  5.4 Adding and deleting a Receiver ....................................................... 85
    5.4.1 Adding a Receiver ....................................................................... 85
    5.4.2 Deleting a DICOM-Protocol Image Receiver .................................. 90
    5.4.3 Changing the DICOM-Protocol Image Receiver settings ................. 90

6. Reading Images (DICOM Image File Reader) .............................. 91
  6.1 What is the DICOM Image File Reader? ......................................... 91
  6.2 DICOM-Image-File Reader window .............................................. 92
    6.2.1 Opening the DICOM Image File Reader window ............................ 92
    6.2.2 Closing the DICOM Image File Reader window ............................ 93
  6.3 Reading captured images ............................................................... 94
  6.4 Creating a scenario example 1 (reading from a recording medium) ... 97
    6.4.1 Overview .................................................................................. 97
    6.4.2 Creating a scenario (example using a recording medium) .............. 98
  6.5 Creating a scenario example 2 (reading from a shared drive) .......... 103
    6.5.1 Overview .................................................................................. 103
    6.5.2 Creating a scenario (example using shared folder) ....................... 103
  6.6 Modifying scenarios ...................................................................... 107
  6.7 Replacing patient data ................................................................. 108
    6.7.1 Changing patient data .............................................................. 108
    6.7.2 Example of using ccrhis.his file ................................................. 109
    6.7.3 Editing the ccrhis.his file ........................................................ 110
7. Received Image Storage and Management (Queue Management Tool) ................................................................. 111
  7.1 Queue Management Tool window ................................................................. 111
    7.1.1 Opening the Queue Management Tool window .................................................. 111
    7.1.2 Closing the Queue Management Tool window ............................................... 112
  7.2 Managing the Archive Queue ........................................................................ 113
    7.2.1 Viewing the Archive Queue ............................................................................ 113
    7.2.2 Re-saving the Archive Queue .......................................................................... 114
    7.2.3 Deleting the Archive Queue ........................................................................... 115
  7.3 Managing the Redistribution Queue .......................................................... 116
    7.3.1 Viewing the Redistribution Queue ................................................................. 116
    7.3.2 Re-transmitting the Redistribution Queue ...................................................... 117
    7.3.3 Deleting the Redistribution Queue ................................................................. 118
    7.3.4 Starting and Stopping the Image Distribution Service ..................................... 118

8. Copying Images (Image Backup Tool) ........................................... 119
  8.1 Backing up Images Automatically .............................................................. 119
    8.1.1 Setting automatic backups ............................................................................. 119
    8.1.2 Running automatic backups .......................................................................... 121
  8.2 Backing up Images Manually ...................................................................... 122

9. Database Backup and Restore ............................................................. 125
  9.1 Database Backup Tool window ...................................................................... 125
    9.1.1 Opening the Database Backup Tool window ................................................... 125
    9.1.2 Closing the Database Backup Tool window .................................................... 126
  9.2 Backing up a database ................................................................................. 127
  9.3 Restoring a database ................................................................................... 129

10. DICOM Query/Retrieve Setting ......................................................... 131

11. Error Messages ..................................................................................... 135
  11.1 Errors ....................................................................................................... 135
  11.2 Warnings .................................................................................................. 136

Index ........................................................................................................ 139
Before Operation

To ensure correct operation of the DR Image Viewer System, be sure that you fully understand the following points.

Database Size

The size of the database is limited to 4 GB due to the usage of the Microsoft SQL Server 2005 Express Edition.
NOTATION

Notation 1

Button names are indicated by [ ].

Notation example: Click [OK].

Notation 2

Available options in the taskbar or menu bar are indicated by [ ], and when options are selected in submenus, the order of selection is indicated by >.

Notation example: Click the commands from the taskbar in the following order.
[Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [System Administrator]

Notation 3

For check boxes, √ indicates a checked option, and □ indicates an unchecked option.

Notation example: To give DR Image Viewer usage privilege to the computer, check Viewer Operation Privilege.

Notation 4

For radio buttons, ● indicates a selected option, and ○ indicates an unselected option.

Notation example: When On is selected, the read images are also stored in the backup folder.

Notation 5

If an operating procedure or description continues from an odd-numbered page to an even-numbered page, "Continued on the following page>>" is written at the bottom right of the odd-numbered page.

Notation 6

If a detailed explanation for the operation or setting is available on another page, the notation (→ page number) is used to refer to this page.
However, if the information is provided in the DR Image Viewer Operation Manual, please refer to the separate DR Image Viewer Operation Manual.

Notation example: The current group ID setting can also be checked at the Group tab of the DR Image Viewer (→ DR Image Viewer Operation Manual).
1. Introduction

1.1 What is the DR Image Viewer System?

The DR Image Viewer System is a software package for storing and displaying images captured using a Canon CXDI digital radiography system (simply called “CXDI” below). The software package comprises image server and image viewer components. The image server is called the DR Image Server, and the image viewer is called the DR Image Viewer.

The DR Image Server is used for user management and to store images captured with the CXDI.

DR Image Server (DICOM-Protocol Image Receiver)

The DR Image Viewer is used to search for and display images stored on the DR Image Server.

DR Image Viewer (Patient tab)
1.2 Using the DR Image Viewer System

This section describes how to store and display captured images.

1.2.1 Receiving images

The DICOM-Protocol Image Receiver (→ 81P.) has a server function and is used to receive and store captured images transferred from the CXDI using the DICOM protocol. The stored images can be displayed using the DR Image Viewer.

1.2.2 Loading from storage medium

Images that are taken in examination vehicles and saved to magnetic optical discs and other storage medium are read by the DICOM image file reader (→ 94P.) and saved to an online folder. The stored images can be displayed using the DR Image Viewer.
1.2.3 Viewing shared drives

Images in shared drives on a network are read by the DICOM image file reader (→ 94P.) and either the images are saved to an online folder, or the storage location information is registered in the database without saving the image.

In this case, the DR Image Viewer displays either the online folder images or the images in the shared drives.

---

**Online folders**

Online folders can only be set for shared folders inside the root folder.
1.3 DR Image Server Components

The DR image server consists of the following software. The software components can be viewed by clicking the commands from the taskbar in the following order.
[Start] > [All Programs] > [Canon Medical] > [DR Image Server]

DR System Manager

The DR System Manager displays buttons for executing software programs.

System Administrator

The DR image server functions can be set here.
1. Introduction

Storage Administrator
The image storage and backup storage can be set here.

![Storage Administrator window](image)

DICOM-Protocol Image Receiver
This receiver can receive captured images through a network and the data can be registered in a database.

![DICOM-Protocol Image Receiver window](image)

DICOM-Image-File Reader
The reader can read captured images from removable media or a shared drive, and the data can be registered in a database.

![DICOM-Image-File Reader window](image)
1. Introduction

Queue Management Tool
This tool can manage the archive queue and redistribution queue.

Queue Management Tool window

Image Backup Tool
This tool can copy backed up images to a local device.
It has Auto Image Backup Tool and Manual Image Backup Tool functions.

Auto Image Backup Tool window and Manual Image Backup Tool window

Database Backup Tool
This tool is used to back up the database.
Should the database become corrupted, it can be restored from backup files.

Database Backup Tool window
2. Opening DR System Manager

Open a DR System Manager for system management. The System Manager has a launcher function for easy use of software programs.

1. **Open the Connection to the server window.**

   Either double-click the System Manager icon on the desktop or click the commands from the taskbar in the following order.
   
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [DR System Manager]

   ![Connection to the server window](image)

2. **Enter the user name and password.**

   The entered password is indicated by *.

   ![Passwords](image)

   **Memo**

   Be extremely careful that you do not forget your password or tell it to others.
2. Opening DR System Manager

3. Log into the server.

Click [OK] in the Connection to the server window. After logging in correctly, the System Information window opens, based on the system setting values (→ 24P). When starting the software for the first time, information about the On-line Image Folder and Back-up Image Folder is not displayed.

![System Information window](image)

When errors occur
If system information is erroneous, the Warning window opens to display the following message: “Error in system information.”
Click [OK] to close the Warning window and read the details in the System Information window.
A flashing icon appears at the item with the error.
4. Open the DR System Manager.

Click [OK] in the System Information window.

<table>
<thead>
<tr>
<th>Button name</th>
<th>Relevant chapter and page</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>3. System Administrator</td>
<td>This option is available only when you log in with administrator privileges.</td>
</tr>
<tr>
<td>Storage Administrator</td>
<td>4. Storage Administrator</td>
<td>This option is available only for users for whom Archive Privilege (→ 15P.) is checked under User Management. The DICOM-Protocol Image Receiver and DICOM Image File Reader cannot be used while the Storage Administrator is running.</td>
</tr>
<tr>
<td>DICOM-Protocol Image Receiver</td>
<td>5. Receiving Images D</td>
<td></td>
</tr>
<tr>
<td>DICOM-Image-File Reader</td>
<td>6. Reading Images D</td>
<td></td>
</tr>
<tr>
<td>Queue Management Tool</td>
<td>7. Received Image Storage</td>
<td></td>
</tr>
<tr>
<td>Image Backup Tool</td>
<td>8. Copying Images (Image</td>
<td></td>
</tr>
<tr>
<td>Database Backup Tool</td>
<td>9. Database Backup and</td>
<td></td>
</tr>
<tr>
<td>DR Image Viewer</td>
<td>DR Image Viewer Operation Manual</td>
<td></td>
</tr>
</tbody>
</table>

[CLOSE] Closes DR System Manager.
2. Opening DR System Manager

MEMO

Auto logout function
If no operation is performed in a set period of time in 3.4.1 System Setting
(→ 24P.), the DR System Manager automatically logs out and its window is
minimized.
Clicking the DR System Manager button on the taskbar opens the Re-Login window.
Log into the DR System Manager again.
3. System Administrator

3.1 Opening and Closing System Administrator

3.1.1 Opening the System Administrator

The system administrator is a function for setting the entire system, and it is operated using an Internet browser. Internet Explorer Version 6.0 and later assures normal operations of the system administrator.

1. Open the System Administrator window.
   Click the commands from the taskbar in the following order.
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [System Administrator]
2 Set to the Login window.
To log in with normal user privileges, click [Normal User] to open the Normal User Login window. To log in with administrator privileges, click [Administrator] to open the Administrator Login window.

![Normal User Login window (when [Normal User] is selected)](image)

Operations from the DR System Manager window
When [System Administrator] in the DR System Manager is clicked, a login window is opened for the privilege selected at the time of login to the DR System Manager.

3 Log in to display the main menu.
Enter the user name and password, and then click [Login].
The main menu varies depending on the login privileges.
For the normal user settings, see 3.10 Normal User Page (→ 65P.).

![Administrator (left) and Normal User (right) Main Menus](image)

Timeout
If there are no operations for about 10 minutes after login, performing any single operation displays the Timeout window. In this case, return to the Login page and login again.
If there are no operations for about 20 minutes, any single operation displays the Session Timeout window. In this case, log out and then log in again.
3.1.2 Closing the System Administrator

To close the System Administrator, either click [File(F)] > [Close(C)] from the menu bar, or click the close button in the top right corner of the window to close Internet Explorer.
3.2 User Management

The User Management menu is used to register, edit, and delete users.

3.2.1 User Registration

To register users and set their access privileges:

1. Display the User Registration window.
   In the Main Menu (Administrator) window, click [User Management] > [User Registration].
2 Enter the user information.  
Make the entries for the following fields, or select the options.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Enter a user name for login within 50 characters.</td>
</tr>
<tr>
<td>Full Name</td>
<td>Enter the user’s full name (maximum 65 characters) as it will appear in the Worklist (All Reports) display in the DR Image Viewer.</td>
</tr>
<tr>
<td>Password</td>
<td><strong>New Password</strong> Enter a new password using at least 6 characters and no more than 20 characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Retype the New Password</strong> Enter the same characters entered as the New Password.</td>
</tr>
<tr>
<td>Usage Privilege</td>
<td>Check this item to enable the setting of the functions below. If this is not checked, neither one can be used.</td>
</tr>
<tr>
<td>Administrator Privilege</td>
<td>Check this item to enable login to the System Administrator with administrator privileges. You can also use the Storage Administrator (→ 71P.) and the Database Backup tool (→ 125P.).</td>
</tr>
<tr>
<td>Archive Privilege</td>
<td>Check this item to enable use of the DICOM-Protocol Image Receiver (→ 85P.), DICOM Image File Reader (→ 91P.), and Queue Management Tool (→ 111P.).</td>
</tr>
<tr>
<td>Viewer Privilege</td>
<td>Check this item to enable to use the DR image viewer. If this is not checked, reporting privilege cannot be used.</td>
</tr>
<tr>
<td>Reporting Privilege</td>
<td>Check this item to enable report input using the DR Image Viewer.</td>
</tr>
</tbody>
</table>

3 Register the user.  
Click [Register].  
User registration is completed once the message “Registration has been finished” is displayed.

Display of Finish Registration message
4. Confirm the settings.
Click User List, Edit, Deletion, and check that the user is registered.

3.2.2 Deleting user information

The user information can be deleted.

1. Display the User List, Edit, Deletion window.
In the Main Menu (Administrator) window, click [User Management] > [User List, Edit, Deletion].

2. Delete the user.
Click [Delete] for the user to be deleted.
The message “Are you sure you delete user?” is displayed. Click [OK].
The user information is removed from the user list.
User that cannot be deleted
The following users cannot be deleted.
- A user that was initially registered.
- Users that have been given Usage Privilege.
- Users that have a report.
- Users that have selected “Detail Examination”.

3.2.3 Editing user information

User information can be edited.

1. Display the User List, Edit, Deletion window.
   In the Main Menu (Administrator) window, click [User Management] > [User List, Edit, Deletion].

   ![User List, Edit, Deletion window](image)

2. Display the Modify User Information window.
   Click **Edit** for the user whose information you want to modify.

   ![Modify User Information window](image)
3. System Administrator

3. Edit the user information or password.

4. Change the User Information or Password.
To change the user information, click [Modify] on the user information side. To change the password, click [Modify] on the password side.
The user information or password is modified once the message “Registration information has been updated” or “Password has been changed” is displayed.

Display of Change Complete message

MEMO

Administrator Privilege and User Privilege
If [Modify] is clicked when the check mark for the Administrator Privilege or Usage Privilege is removed from a current login user, the user is automatically logged out.
Be aware that Administrator login is not possible when a user has no Administrator Privilege, and login itself is not possible when a user has no Usage Privilege.
3.3 Computer Management

The Computer Management Menu is used to register, edit, and delete computers that connect to the DR Image Server and DR Image Viewer.

3.3.1 Computer Registration

To set the computer that can be connected to the server:

1. Display the Computer Registration window.
   In the Main Menu (Administrator) window, click [Computer Management] > [Computer Registration].

2. Enter the computer name.
   To input the currently used computer name automatically, click [Get Automatically].
   When [Get Automatically] is not used, enter the computer name directly.
3. System Administrator

3. Set the Usage Privileges for the DR Image Viewer.
   To give DR Image Viewer usage privilege to the computer, check Viewer Operation Privilege.
   If this option is unchecked, a connection cannot be made from the DR Image Viewer to the server.

4. Register the computer.
   Click [Register].
   The message “Computer registration has been finished.” is displayed, and the computer registration is completed.

Display of Finish Registration message

5. Confirm the settings.
   Click the Computer List, Edit, Deletion to check that the computer is registered.

Computer List, Edit, Deletion window
3.3.2 Deleting computers

To delete computer information:

1. Display the Computer List, Edit, Deletion window.
   In the Main Menu (Administrator) window, click [Computer Management] > [Computer List, Edit, Deletion].

2. Delete the computer.
   Click [Delete] for the computer to be deleted. A deletion confirmation message is displayed. Click [OK].
   The computer information is deleted from the computer list.
3.3.3 Editing computer information

To change the computer name and operation privileges:

1. Display the Computer List, Edit, Deletion window.
   In the Main Menu (Administrator) window, click [Computer Management] > [Computer List, Edit, Deletion].

2. Click Edit for the computer whose settings will be changed.
   The Computer Name and Operation Privilege can now be edited.

3. Edit the computer name.
   If you want to change the Computer Name, enter the new computer name in Computer Name.

4. Set the Operation Privilege.
   Check Operation Privilege to allow connection of the computer to the server.
5 Change the settings.
   Click **Update**.
   The settings are changed.
3.4 Various Setting

The Various Settings menu is used to set the system, group ID, and setting policy.

Various Setting Menu window

3.4.1 System Setting

Make settings related to System Information, Auto Logout, Object Save, Date Format and Database.

1. Display the System Setting window.

In the Main Menu (Administrator) window, click [Various Setting] > [System Setting].

System Setting window
2 Set System Information.

If "Show "System Information" on start-up" is not checked, system information is not displayed except when an error occurs. When [Return to default value.] is clicked, values of all items are reset to their defaults.

<table>
<thead>
<tr>
<th>Display Item</th>
<th>Setting Item</th>
<th>Warning Level</th>
<th>Error Level</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Rest Space</td>
<td>Set MB.</td>
<td>Set MB.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td></td>
<td>Backup elapsed Days</td>
<td>Set the number of days.</td>
<td>Set the number of days.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td>Queue Information</td>
<td>Rest Queues (Archive)</td>
<td>Set the number of queues.</td>
<td>Cannot be set.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td></td>
<td>Rest Queues (Redistribution)</td>
<td>Set the number of queues.</td>
<td>Cannot be set.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td>Online Folder</td>
<td>Rest Space</td>
<td>Set MB.</td>
<td>Set MB.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td>Backup Folder</td>
<td>Rest Space</td>
<td>Set MB.</td>
<td>Set MB.</td>
<td>Default is displayed.</td>
</tr>
<tr>
<td>License</td>
<td>Rest Days</td>
<td>Set the number of days.</td>
<td>Set the number of days.</td>
<td>Default is displayed.</td>
</tr>
</tbody>
</table>

3 Set Auto Logout.

To use the auto logout function, check "Use "Auto Logout" and set the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Logout Time</td>
<td>If there is no operation of the DR system manager and DR image viewer for the set period of time, the system logs out automatically.</td>
</tr>
<tr>
<td>Message Display Time</td>
<td>The message is displayed for the period of time calculated back from the logout time. (Only for the DR Image Viewer)</td>
</tr>
</tbody>
</table>

4 Set Object Save.

Determine whether the object on the DR Image Viewer is to be shared among all users or it is to be stored for each user.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share the objects by all users.</td>
<td>Owners are not assigned to objects, so they can be manipulated by any user.</td>
</tr>
<tr>
<td>Save the objects by each user.</td>
<td>Owners are assigned to objects, so they can only be manipulated by their owners.</td>
</tr>
</tbody>
</table>
5. Set Date Format.
Select YYYY/MM/DD, MM/DD/YY, or DD/MM/YYYY as the format for displaying dates in the DR Image Viewer.

6. Set the automatic backup of the database.
When backing up the database automatically, check “Enable auto-back up function for the database.”
A backup file of the study database is created every time the user starts up the computer in which Microsoft SQL Server 2005 Express Edition is installed.
The backup filename is automatically assigned as follows.
Study database: drs_bak.dat
However, the log database is not backed up automatically.

7. Save the setting.
Click [Setting].
The message “The setting has been finished.” is displayed and the settings are saved.

Display of Setting Complete message
3.4.2 Setting the group ID

Note: If the current group ID setting is changed while an operation is in progress, the change will not be applied to the patient information that was registered to the database before change.

To set the group ID for classifying the patient information in the DR Image Viewer:

1. Display the Current Group ID Setting window.
   In the Main Menu (Administrator) window, click [Various Setting] > [Current Group ID Setting].

2. Display the Group ID Setting window.
   Click [Set]. A window opens and a warning message "If the digits area for the Group ID is changed, the management for the grouping is modified. This might cause the serious problem in managing the patients." is displayed. Click [OK].

Continued on the following page >>
3. System Administrator

3. Set the group ID.

Select Use Group ID under Use of Group ID, and then click the respective [ ] buttons to select the Start Position and End Position for the Group ID Digits Area. To reset the Start Position and End Position, click [Reset] in the Group ID Digits Area. To reset the Group ID Setting window, click [Reset] in the Set Group ID. In this example, Start Position is set to 1 and End Position is set to 4.

4. Determine the group ID.

Click [Setting]. A window opens and a warning message "If the digits area for the Group ID is changed, the management for the grouping is modified. This might cause the serious problem in managing the patients." is displayed. Click [OK].

The message "Finish Group ID setting" is displayed, and the group ID setting is completed.
5 Confirm the settings.
Click **Reconfirm Group ID**, and check that the settings have been changed. The current group ID setting can also be checked at the Group tab of the DR Image Viewer (→ DR Image Viewer Operation Manual).
3.4.3 Setting Policy

To enable or disable changes to certain software settings:

1. Display the Setting Policy (Input Keyword) window.
   In the Main Menu (Administrator) window, click [Various Setting] > [Setting policy].

2. Open the Setting Policy (Setting) window.
   Enter the Keyword, and then click [OK].
3. System Administrator

Initial keyword and changing the keyword
When using Setting Policy for the first time, or when changing the keyword, click [Change Keyword] to set the new keyword in the Setting Policy (Change Keyword) window. In particular, when changing the keyword for the first time, enter “canon” in the Old Keyword.

Be careful not to forget or tell others your keyword as well as the password.

3. Change the settings.
Check the items to be enabled.

<table>
<thead>
<tr>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Administrator</td>
<td>Permit setting of “Delete online files automatically when the free space is lacked” to be changed. When this option is checked, options for the deletion of online folders can be set (√ 75P.).</td>
</tr>
<tr>
<td>DICOM-Protocol Image Receiver and DICOM-Image-File Reader</td>
<td>Permit setting of “Ask to erase database every time the scenario starts” in DICOM-Image-File Reader to be changed. When this option is checked, options for the deletion of databases can be set (√ 98P.).</td>
</tr>
<tr>
<td>DICOM-Protocol Image Receiver and DICOM-Image-File Reader</td>
<td>Permit setting of “ID Matching” in DICOM-Image-File Reader and DICOM-Protocol Image Receiver to be changed. When this option is checked, options for checks when registering patient data to databases (DICOM Image File Reader (√ 101P.) and DICOM Protocol Image Receiver (√ 81P.)) can be set.</td>
</tr>
<tr>
<td>DICOM-Protocol Image Receiver and DICOM-Image-File Reader</td>
<td>Permit starting DICOM-Protocol Image Receiver without login. When this option is checked, the window for connecting to the server does not open when the DICOM Protocol Image Receiver is opened (√ 82P.).</td>
</tr>
</tbody>
</table>
3. System Administrator

### Setting item

<table>
<thead>
<tr>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>Enable “Batch Replacement”. When this option is checked, the database correction function (→ 53P.) can be set.</td>
</tr>
<tr>
<td>Permit deleting image that is not backed-up when “Online File Deletion.”</td>
<td>When this option is checked, online files that have not been backed up can be deleted (→ 57P.).</td>
</tr>
</tbody>
</table>

4. Save the setting.
   Click [Setting].
   “The setting has been finished.” is displayed and the settings are saved.

![Display of Setting Complete message](image-url)
3.5 License Management

Registration of licenses allows a larger number of computers to be connected to a server simultaneously and enables optional functions.

3.5.1 Current License

To check the currently registered license:

1. Display the Current License window.
   In the Main Menu (Administrator) window, click [License Management] > [Current License].
   The Current License window is displayed, and the current license status can be verified.
3.5.2 License Request

To create and save the license request file:

1. **Display the License Request window.**
   In the Main Menu (Administrator) window, click [License Management] > [License Request].

2. **Confirm handling of personal information.**
   After confirmation is completed, click [License Request Page].

3. **Enter the information.**
   Enter information in all fields.
   The CXDI Serial Number, however, is not a mandatory field.
4 Confirm the entered contents.
   Click [Confirm].
   The Input Reconfirmation window is displayed.

5 Display the License Request File Download window.
   Click [Create the License Request File].
6. Download the license request file.
   Click [Download the License Request File].
   The License Request File Download window is opened. Click [Save].
   The download of the license request file starts.

   ![File Download dialog]

7. Specify the storage location, and then save.
   In the Save As window, specify the folder where the file will be saved, and then click [Save].
   Saving of the license request file starts.

   ![Save As dialog]
8 Download is completed.

When the download is completed, the Download complete window opens.
(The window does not open for some customer settings.)
Send the saved license request file to the distributor or Canon representative where you made the purchase.
3.5.3 License registration procedure

Note: After a license is registered, the operating privilege settings for the computer may be disabled.
In this case, check the operating privileges by referring to section 3.3.3 Editing computer information (→ 22P.).

Once the saved license request file is sent to the distributor or Canon representative where you made the purchase, a license setting file is sent in return. The license setting file is used to register the license.

1. Display the License Registration window.
   In the Main Menu (Administrator) window, click [License Management] > [License Registration].

   ![License Registration window]

2. Select the license setting file.
   Click [Browse...] to open the Choose file window, and then select the file.
3 Register the license.
Click [Register]. After the license is registered, the message “The License Registration has been finished” is displayed.

Display of License Registration Complete message

4 Confirm the settings.
Click **Confirm License**, and then check the details of the registered license.

Current License window
3.6 Patient Data Registration

To register patient data for new patients who are not registered in the database:
- Manual registration - To register patient data manually, select [Manual Registration].
- Batch registration - To load a patient data setting file to register it in a single operation, select [Batch Registration].

![Patient Data Registration Menu window](image)

3.6.1 Manual Registration

To register patient data manually:

1. Display the Manual Registration window.
   In the Main Menu (Administrator) window, click [Patient data registration] > [Manual Registration].

![Manual Registration window](image)
2 Enter the patient data.

<table>
<thead>
<tr>
<th>Item</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient ID</td>
<td>Enter a patient ID consisting of no more than 64 alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td>This item is required.</td>
</tr>
<tr>
<td>Birth Date</td>
<td>Input the date according to the selected display format.</td>
</tr>
<tr>
<td>Sex</td>
<td>Select Male, Female, or Other.</td>
</tr>
</tbody>
</table>

3 Start registration.

Click [Register].

A registration confirmation message is displayed. Click [OK].

After registration is completed, the message “Manual registration has been finished.” is displayed.

![Manual Registraton Complete message](image)
4. Either continue registration or check the registration list.

To continue registering patient data, click [Perform to register again], and then return to step 2.

To check the registration list, click Confirm the registration list, and then check the registered patient data.

Registration List window
3.6.2 Batch registration

This section describes how to register multiple patients in the database in a single operation by reading a patient data file (ccrhis.his). The items that are registered are Patient ID, Patient Name, Sex and Birth Date. For details the ccrhis.his file, refer to 6.7.3 Editing the ccrhis.his file (→ 110P.).

1. Display the Batch Registration (Read File) window.
   In the Main Menu (Administrator) window, click [Patient data registration] > [Batch Registration].

2. Select the patient information file.
   Click [Browse...] to open the Choose file window, and then select the patient data file.

3. Start the test.
   Click [Start Test].

Continued on the following page >>
4. Check the test results.
The Batch Registration (Test Result) window opens, and the test results are displayed. Check the Error data in this window.

![Batch Registration (Test Result) window]

5. Check the Success data.
Click [Show Success Data] to display the Batch Registration (Test Result) window, and then check the Success data.
After checking the data, click [Close window].

![Batch Registration (Test Result) window]
6 Start registration.
Click [Start Registration]. A window opens and the message “Are you sure you want to start registering the data in the database?” is displayed. Click [OK]. After registration is completed, the message “Batch registration has been finished.” is displayed.

7 Check the registration list.
Click Confirm the registration list, and then check the registered patient data.
3.6.3 Deleting patient data entered using batch registration

It is possible to display a list of patients registered in the database and to delete multiple patients in a single operation.

1. Display the Registration List window.
   In the Main Menu (Administrator) window, click [Patient Data Registration] > [Registration List].

2. Select the patient data.
   Click [Delete] on the right of the unnecessary patient data.
   A window opens and the message "Are you sure you want to start registering the data in the database?" is displayed.

3. Delete the patient data.
   Click [OK].
3.7 Data Replacement

To replace the patient data registered in the database:
To replace data for one patient at a time, select [Manual Replacement]. To replace data for multiple patients in a single operation, select [Batch Replacement] (→ 53P.).

Data Replacement Menu window

About data replacement

Data replacement only changes the patient data registered in the database. It does not alter stored patient image data.

However, selecting the save image or DICOM transfer functions in the DR Image Viewer overwrites the data in the database and then outputs it.
3.7.1 Manual Replacement

To replace the patient manually:

1. Display the Manual Replacement (Search Patient) window.
   In the Main Menu (Administrator) window, click [Data replacement] > [Manual Replacement].

2. Enter or select the search conditions.
   Enter or select the search conditions.
   Partial match and Full match are enabled only when the Patient ID or Patient Name is entered.

3. Execute the search.
   Click [Search].
   The Manual Replacement (Search Result) window opens, and the search results are displayed.
Replacement of the patient data.

Refer to Replacement of the patient data, Replacement of the registration location of study data, or Replacement of the registration location of series data, and then replace the patient data.

To replace the patient data:

1. Click [Replace Patient Data] for the intended patient under the [Patient Data] column to open the Manual Replacement (Replace Patient) window.

2. Enter the changes for the patient data in the Replacement procedure and contents column.

   - If Replace with the registered patient is selected, click [Show the search page] to open the Manual Replacement (Search Patient) window, and find the patient having the patient data that will be used to make the changes.
   - It is not possible to enter the patient data directly into the items.
   - If Replace data except patient ID is selected, enter the items other than the Patient ID.
   - If Replace only patient ID is selected, enter the Patient ID.
   - If Replace all data and Register as a new patient is selected, enter the patient data. In this case, be sure to enter the Patient ID.

3. Click [Execute] to replace the patient data.
Replacement of the registration location of study data

1. Click **Show Study** for the intended patient in the [Patient Data] column to display the study data in the [Study Data] column.

2. Click [Move Study] for the intended study date in the [Study Data] column to open the Manual Replacement (Move Study) window.

3. Set the patient data at the registration location in the “Movement procedure and contents” column.
   - When you select **Move to the registered study**, click [Show the search page] to open the Manual Replacement (Search Patient) window and find the patient data that is to be the registration location.
   - When you select **Move to a new study**, enter the patient data that is to be the registration location. In this case, be sure to enter the **Patient ID**.

4. Click [Execute] to replace the registration location.

Replacement of the study data

1. Click **Show Study** for the intended patient in the [Patient Data] column to display the study data in the [Study Data] column.

2. Click [Replace Study Data] for the intended study date in the [Study Data] column to open the Manual Replacement (Replace Study) window.
3. Set the study data in the Replacement contents column.
   Enter the Accession No. and Study Description as study data.
4. Click [Execute] to replace the study data.

Replacement of the registration location of series data
1. Click Show Study for the intended patient in the [Patient Data] column to display the study data in the [Study Data] column.
2. Click Show Series for the intended study date in the [Study Data] column.
3. Click [Move Series] for the intended series number in the [Series Data] column to open the Manual Replacement (Move Series) window.

4. Set the study data at the registration location in the Movement procedure and contents column.
   If the Move to the registered study is selected, click [Show the select page] to open the Manual Replacement (Select Study) window, and select the study at the registration location.
   If Move to a new study (Study UID is issued automatically.) is selected, enter the Accession No. and Study Description.

5. Click [Execute] to replace the registration location.
5 Check the replaced patient data. After the registration data is replaced, the message “Patient data has been replaced.” is displayed, and the replaced data is shown.

Display of Patient Data Replacement Complete message
3.7.2 Batch Replacement

Note: To perform batch replacement, check the System Administrator item on the Setting Policy window (→ 30P.).

To replace data for multiple patients registered in the database in a single operation by reading a patient data file (ccrhis.his):

This operation searches the database using the accession numbers contained in the patient data file and overwrites five patient data items (Patient ID, Patient Name, Sex, Birth Date, and Comment) when a match is found.

For details on the ccrhis.his file, refer to 6.7.3 Editing the ccrhis.his file (→ 110P.).

1 Display the Batch Replacement (Read File) window.

In the Main Menu (Administrator) window, click [Data Replacement] > [Batch Replacement]

Batch Replacement (Read File) window

Continued on the following page >>
2 Verify the replacement conditions.

Click [ID Matching Specification] to open the ID Matching Specification window, and then verify the replacement conditions of the patient data. After verifying the conditions, click [Close window].

ID Matching Specification window

Comparison of patient data
The Accession No. of the patient data file (→ 110P.) is searched by the Patient ID in the database.
If the matching Patient ID is found in the database, the patient names, birth dates and sexes of both patient data are compared.
The full matching patient data in the database is overwritten.

3 Select the patient information file.
Click [Browse...] to open the Choose file window, and then select the file.

Choose File window
4. Start the test, and check the test results.
   Click [Start Test].
   The Batch Replacement (Test Result) window displays, and the test results are displayed. Check the error and warning data in this window.

![Batch Replacement (Test Result) window](image)

**Error and warning data**
Based on the conditions displayed in the ID Matching Specification window, the patient information in the patient information file is classified into SUCCESS, ERROR, or WARNING.
If patient information indicates an error, correct the patient information file, click [Back], and then redo the procedure from step 2.

5. Check the Success data.
   Click [Show Success Data] to open the Batch Replacement (Test Result) window, and then check the Success data.
   After checking the data, click [Close window].

![Batch Replacement (Test Result) window](image)
Start replacement.

Click [Start Replacement].

A window opens and the message “Are you sure you want to start registering the data in the database?” is displayed. Click [OK].

After replacement is completed, the message “Batch Replacement has been finished.” is displayed.

Display of Batch Replacement Complete message

MEMO

Errors in patient data

If [Start Replacement] is clicked and the patient data contains errors, the message “There is data that will fail to be replaced. Are you sure you want to start replacing the data in the database?” is displayed. To continue, click [OK]. To cancel, click [Cancel].
3.8 Deleting Online Files

To delete images from an online folder and delete the image information from the database:
To delete an image that is not backed up, refer to 3.4.3 Setting Policy (→ 30P.) and make sure the Permit deleting image that is not backed-up when “Online File Deletion.” option is checked.

1. Display the Online File Deletion (Search) window.
   Click [Online File Deletion] in the Main Menu (Administrator) window.

2. Enter or select the search conditions.
   Select Search by patient or Search by register date, and enter or select the search conditions.
   Partial match and Full match are enabled only when the Patient ID, Patient Name or Study Description is entered.
3. Execute the search.

Click [Search].

When **Search by patient** is selected in step 2, the Online File Deletion (Search Result For Patient) window opens. When **Search by register date** is selected, the Online File Deletion (Search Result For Register Date) window opens.

![Online File Deletion (Search Result For Patient) window](image)

**Performing a search by registration date**

When searched by register date, a list of relevant studies is displayed. Check the checkbox of the study to be deleted, or check Select All and click [Delete]. An window appears to show the message “Are you sure you want to delete the online file of the selected study from the online folder?” To delete the file, click [OK].

![When searched by registration date](image)

4. Display the search results.

The study information, series information and image information of the patient who meets the search criteria are displayed.

When [Show Picture] is clicked in the [Image Data] column, the image is displayed.
5. Select the images to be deleted.
Images can be deleted by individual study, individual series or individual image. When deleting images by individual series, click [Delete] for the image to be deleted in the [Series Data] column. A deletion confirmation message is displayed. Click [OK]. After the image is deleted, the message "Deletion has been finished." is displayed, and a list of the deleted images is shown.

![Display of Online File Deletion Complete message]

6. To delete other images, return to the search screen. To delete other images, click Perform to delete again, and redo the procedure from step 2.
3.9 Log Reference

The Log Reference menu is used to view a session logs and data access logs.

3.9.1 Session Log

To view session logs:

1. Display the Session Log (Search) window.
   In the Main Menu (Administrator) window, click [Log Reference] > [Session Log].
3. System Administrator

2. Search for a log.
   Enter or select search conditions and click [Search].

   ![Session Log (Search Result) window]

3. Display the log.
   Select the list and then click the [Show All Log] or [Show Log].

   ![Session Log (Log List) window]

   **Page selection**
   To select a page of the list, click the page number at the lower right of the list.

   Continued on the following page >>
4. Display the detail information of the log. 
   Click the **Detail Info** of the target log. 
   Detail information is displayed at the bottom of the window.

3.9.2 Data Access Log

To view data access log(s):

1. Display the Data Access Log (Search) window. 
   In the Main Menu (Administrator) window, click [Log Reference] > [Data Access Log].
2 Search for a log.
Enter or select search conditions and click [Search].

Data Access Log (Search Result) window

3 Display the log.
Select the list and then click the [Show All Log] or [Show Log].

Data Access Log (Log List) window

Page selection
To select a page of the list, click the page number at the lower right of the list.
Display the detail information of the log.

Click the **Detail Info** of the target log.

Detail information is displayed at the bottom of the window.
3.10 Normal User Page

Use [Normal User] to start the System Administrator, and then open the Main Menu (Normal User) window.

3.10.1 Registration Information

To verify the registration information of the user who has logged in:

1. Display the Registration Information window.
   In the Main Menu (Normal User) window, click [Registration Information].
   Registered data cannot be changed.
3.10.2 Changing the password

To change the password:

1. Display the Change Password window.
   In the Main Menu (Normal User) window, click [Change Password].

2. Enter the old password.
   The entered password is indicated by ● or *.

3. Enter the new password.
   Enter a new password, and then enter it again for confirmation.
   The entered password is indicated by ● or *.
4. Change the password.
   Click [Change].
   The message “Password has been changed” is displayed, and the password change is completed.

3.10.3 Log Reference
   To view data access logs:
   On the pages for normal users, only the logs of the user who has logged in can be viewed.

1. Open the Data Access Log (Search) window.
   In the Main Menu (Normal User) window, click [Log Reference].
2 Search for a log.
Enter or select search conditions and click [Search].

![Data Access Log (Search Result) window]

3 Display the log.
Select the list and then click the [Show All Log] or [Show Log].

![Data Access Log (Log List) window]

**Page selection**
To select a page of the list, click the page number at the lower right of the list.
4. Display the detail information of the log.
   Click the **Detail Info** of the target log.
   Detail information is displayed at the bottom of the window.

![Data Access Log (Log List) window](image-url)
3. System Administrator
4. Storage Administrator

The Storage Administrator sets the online folder where read or received images are saved and the backup folder where images are backed up.

4.1 Storage Administrator Window

4.1.1 Opening the Storage Administrator window

Note: The Storage Administrator cannot be executed while the DICOM Protocol Image Receiver or DICOM Image File Reader is running.

Click [Storage Administrator] in the DR System Manager to open the Storage Administrator window directly.

Note: When using Windows Vista, the administrator's authority is required to start the Storage Administrator.

1. Open the Connection to the server window.
   Click the commands from the taskbar in the following order.
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Storage Administrator]

2. Enter the user name and password.
   The entered password is indicated by *.

   **Passwords**
   Be extremely careful that you do not forget your password or tell it to others.

Continued on the following page >>
3 Open the Storage Administrator window.
   Click [OK] in the Connection to the server window.

![Storage Administrator window]

If the System Information window is open
The System Information window (→ 8P.) may open depending on the System Settings
(→ 24P.).
In this case, confirm the information displayed, and then click [OK].

4.1.2 Closing the Storage Administrator window
Click [Close] in the Storage Administrator window.
4.2 Setting the online folder

This section describes how to set the folder where images are saved. Online (→ 91P.) images received over the network or read by the file reader are saved to this folder.

4.2.1 Adding online folders

1. Open the Storage Administrator window.

![Storage Administrator window]

2. Open the Browse Shared Folder window.

   Click [Add].

   The local path to the shared folder directly under the root folder of the computer and the shared folder name are displayed.

![Browse Shared Folder window]

Online folders

Only shared folders directly under the root folder can be set as online folders.

To set the shared folder, click [Enable Access] on the Sharing tab in the Properties window, and assign Read access right to the required users in Enable Shared Access.

For details about the settings, follow the instructions of your network administrator.
3 Select the online folder.
Click the folder to add to the online folders.

4 Add the online folder.
Click [OK].
The online folder is added.

**Memo**
When saving an image to the online folder, the image information is registered in the database when receiving or reading the image, and then the image is saved to the designated folder.

The DR Image Viewer is used to browse the database and retrieve images, in this case, the images saved to the online folder are retrieved.

On the other hand, if an image is not saved to the online folder (when the online access option is not checked in the DICOM Image File Reader), only the image information is registered to the database.

In this case, the DR Image Viewer browses the database, and the image is retrieved from an external folder.
4.2.2 Changing online folder settings

Note: To change the online folder settings, check the System Administrator item on the Setting Policy (→ 31P.) window.

1. Open the Storage Administrator window.

2. Select the online folder.
   Click the online folder where the settings will be changed.

3. Open the Online Folder Detail Setting window.
   Click [Detail].
4. Storage Administrator

Make the online folder advanced settings.

Note: If you do not back up the images to a backup folder (→ 79P.), do not check “Delete online files automatically when the free space is lacked.” Otherwise, you will be unable to recover deleted images.

In the state immediately after installation, the options except for the Remaining Free Space Threshold value, cannot be set unless the Setting Policy (→ 31P.) is changed.

<table>
<thead>
<tr>
<th>Display</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remaining Free Space Threshold value</td>
<td>Enter the amount of space in MB units reserved as work space for the computer.</td>
</tr>
<tr>
<td>Delete online files automatically when the free space is lacked.</td>
<td>When this option is checked, online files are deleted in order of registration date (the oldest file is deleted first) when images are saved and the amount of free disk space is less than the remaining free space. If the option is unchecked, images cannot be saved when the amount of free disk space becomes less than the remaining free space.</td>
</tr>
<tr>
<td>Delete online files even if they are not backed up.</td>
<td>This can be set only when the above setting “Delete online files automatically when the free space is lacked.” is checked. Normally, images saved to the online folder cannot be deleted unless there is a copy in the backup folder. When this option is checked, images that do not have copies in the backup folder can be deleted.</td>
</tr>
<tr>
<td>The number of deleting images</td>
<td>This can be set only when the above setting “Delete online files automatically when the free space is lacked.” is checked. This selects the number of images that can be deleted in one operation when deleting the online files. Click [], and then select from 5, 10, and 15.</td>
</tr>
<tr>
<td>Also delete the database records automatically.</td>
<td>This can be set only when the above setting “Delete online files automatically when the free space is lacked.” is checked. If this option is checked, deleting an image also deletes the image registration data from the database. If this option is unchecked, the database data will not be deleted even if an image is deleted.</td>
</tr>
</tbody>
</table>

5. Change the settings.

Click [OK].
4.2.3 Changing online folders

To change the online folder currently in use to another folder:
Before proceeding with this operation, delete the shared settings for the online folder currently in use.

1. Open the Storage Administrator window.

![Storage Administrator window]

2. Select the online folder.
   Click the online folder that you want to change.

3. Open the Browse Shared Folder window.
   Click [Modify].
   The local path to the shared folder directly under the root folder of the computer and the shared folder name are displayed.

![Browse Shared Folder window]

4. Select the online folder.
   Click the folder you wish to use as the new online folder.

5. Change the online folder.
   Click [OK].
   The online folder selected in step 2 is changed to the online folder selected in step 4.
4.2.4 Deleting online folders

To delete the online folder before operation:
The online folder cannot be deleted once an image is saved to it.

1. Open the Storage Administrator window.

![Storage Administrator window]

2. Select the online folder.
   Click the online folder that you want to delete.

3. Delete the online folder.
   Click [Delete].
   The message “This online folder will be removed. Do you want to continue?” is displayed. Click [Yes].

Deleting an online folder that is already in use
If you select an online folder that is already in use and click [Yes], the message “On-line folder cannot be changed because it has already been used” is displayed to indicate that you cannot delete the folder.
4.3 Setting the backup folder

To set a backup folder where copies of images are saved:

1. Open the Storage Administrator window.

![Storage Administrator window]

2. Set the backup folder.

<table>
<thead>
<tr>
<th>Display</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Path</td>
<td>This folder stores copies of images saved in the online folder. Click [Browse...] to open the Browse for Folder window, and then set the root path.</td>
</tr>
<tr>
<td>Index Type</td>
<td>Click ﬁle type, and then select CSV file (<em>.csv), HTML file (</em>.htm), or Microsoft Access (*.mdb) from the format list.</td>
</tr>
<tr>
<td>Folder Capacity</td>
<td>Enter the maximum size in MB units based on the size of the media used for backup. Sub-folders are created with the entered value as the maximum storage capacity.</td>
</tr>
</tbody>
</table>

3. Save the setting.
   Click [Apply].
Using the backup folder

The DR Image Viewer can retrieve the image from the backup folder when images cannot be retrieved from the online folder due to an error or other problems. Media number folders (nnnnnn: 6-digit numbers) are automatically created under the backup folder for storing images (see figure below).

If the image cannot be retrieved from either the online folder or the backup folder, the Browse for Folder window is displayed asking you to specify the folder to browse in. (Only when the backup folder is set.)

In this case, the images can be retrieved if the backup folder was saved to a storage medium.
5. Receiving Images (DICOM-Protocol Image Receiver)

5.1 What is the DICOM-Protocol Image Receiver?

The DICOM-Protocol Image Receiver has a server function for receiving and saving images that are sent by DICOM protocol.

The received images are saved to the online folder set by the Storage Administrator (→ 71P.).

This chapter describes how to set the server functions of the DICOM-Protocol Image Receiver.

<table>
<thead>
<tr>
<th>Description</th>
<th>Relevant chapter and page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening the DICOM-Protocol Image Receiver window</td>
<td>5.2 DICOM-Protocol Image Receiver window (→ 82P.)</td>
</tr>
<tr>
<td>Starting and stopping the Receiver Service</td>
<td>5.3 Starting and stopping the Receiver Service (→ 84P.)</td>
</tr>
<tr>
<td>Adding and deleting a Receiver</td>
<td>5.4 Adding and deleting a Receiver (→ 85P.)</td>
</tr>
</tbody>
</table>
5.2 DICOM-Protocol Image Receiver window

5.2.1 Opening the DICOM-Protocol Image Receiver window

Note: The DICOM-Protocol Image Receiver can be used only by the user who has checked Archive Privilege in the Access Privilege field (→ 15P.). The DICOM-Protocol image reception function cannot be executed during execution of the Storage Administrator.

The DICOM Protocol Image Receiver window can be opened directly by clicking [DICOM Protocol Image Receiver] in the DR System Manager.

**Registering to Startup Menu**

Make the following settings to have the DICOM-Protocol Image Receiver window open automatically when the computer is started.

- Copy the DICOM-Protocol Receiver shortcut from the Start menu to the [Startup] folder.
- Check Archive Privilege for the initially registered user (user name: admin).

1. Open the Connection to the server window.

Click the commands from the taskbar in the following order.

[Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [DICOM-Protocol Image Receiver]

**Connection to the Server window**

2. Enter the user name and password.

The entered password is indicated by *.

**Passwords**

Be extremely careful that you do not forget your password or tell it to others.
3 Opening the DICOM-Protocol Image Receiver window
Click [OK] in the Connection to the server window.

5.2.2 Closing the DICOM-Protocol Image Receiver window
Click [Close] on the DICOM-Protocol Image Receiver window.
Even when the window is closed, the DICOM-Protocol Image Receiver operation is not terminated.

5.2.3 Quitting the DICOM-Protocol Image Receiver
Right-click the DICOM-Protocol Image Receiver icon displayed on the taskbar, and click [Exit].
If you click [Exit] for a receiver for which the Status is displayed as Start, a window opens displaying the warning “This will close the DICOM-Protocol Image Receiver window and stop all image receivers”.
Click [OK] to stop all receivers.
5.3 Starting and stopping the Receiver Service

Image receiver service is started and stopped by the Start (□) and Stop (□) button. If you do not wish to display it while the receiver service is in progress, close the DICOM-Protocol Image Receiver window.

5.3.1 Starting receiver service

If Startup Type is set to Auto in the receiver settings, the receiver service starts automatically when the DICOM-Protocol Image Receiver window is opened.

If it is set to Manual, click the service name, and then click the Start (□) button. The Status changes to Start, and receiver service starts.

5.3.2 Stopping receiver service

Click the service name, and then click the Stop (□) button. The Status changes to Stop, and receiver service stops.
5.4 Adding and deleting a Receiver

5.4.1 Adding a Receiver

Note: To set the ID matching and SOP Instance UID matching, check DICOM-Protocol Image Receiver and DICOM-Image-File Reader setting option under setting option under Setting Policy (→ 30P.).

1. Open the General window.
   Click [Add] in the DICOM-Protocol Image Receiver window.

![General window](image)

2. Set parameters in the General window.
   Set parameters and click [Next].

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>The Service Name must be no more than 50 characters long.</td>
</tr>
<tr>
<td>Startup Type</td>
<td>Auto: Receiver service starts automatically when the DICOM-Protocol Image Receiver window is opened.</td>
</tr>
<tr>
<td></td>
<td>Manual: Receiver service is stopped when the DICOM-Protocol Image Receiver window is opened, and it is started by clicking the Start button ( ).</td>
</tr>
<tr>
<td>Description</td>
<td>This disables the receiver.</td>
</tr>
<tr>
<td>State Start</td>
<td>Start: The receiver service is started by clicking this button.</td>
</tr>
<tr>
<td></td>
<td>Stop: The receiver service is stopped by clicking this button.</td>
</tr>
</tbody>
</table>

The Description must be no more than 50 characters long.
   Set parameters and click [Next].

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling AE Title</td>
<td>The Calling AE Title must be no more than 16 characters long. If nothing is entered, any calling AE title is received.</td>
</tr>
<tr>
<td>Receiver AE Title</td>
<td>The Receiver AE Title must be no more than 16 characters long.</td>
</tr>
<tr>
<td>Port Number</td>
<td>The Port Number must be a value between 1 and 65,535.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Enter the parameters.</td>
</tr>
</tbody>
</table>

4. Set the storage and backup methods.
   Set parameters and click [Next].

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Compression</td>
<td>If On is selected, the images to be stored in the online file are compressed.</td>
</tr>
</tbody>
</table>
5. Receiving Images (DICOM-Protocol Image Receiver)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup File</td>
<td>When On is selected, the read images are also stored in the backup folder. If images are saved to the backup folder, the images can be viewed in the DR Image Viewer even if they are deleted from the online folder.</td>
</tr>
<tr>
<td>BackupFolder</td>
<td>The folder set in 4.3 Setting the backup folder (→ 79P.) is displayed. The backup folder cannot be changed in this window.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>When On is selected, the images to be saved in the backup folder are compressed.</td>
</tr>
<tr>
<td>Index Type</td>
<td>The settings made in 4.3 Setting the backup folder (→ 79P.) are displayed. The setting cannot be changed in this window.</td>
</tr>
<tr>
<td>Folder Capacity</td>
<td></td>
</tr>
</tbody>
</table>

**Backups**

When saving images, it is recommended that you save the entire subfolders to more than one storage medium in addition to the backup folder.

For information about backing up images to offline media, see 8. Copying Images (Image Backup Tool) (→ 119P.).

**Warning messages**

If Off is selected for Image Compression, a window opens and the following message is displayed: "The compression method of this system is lossless compression. The compression can save space on disk." Click [OK] to close the window.

---

5 Set parameters in the ID Matching window.

Set parameters and click [Next].

This parameter can be set only when editing is enabled in Setting Policy (→ 30P.).
5. Receiving Images (DICOM-Protocol Image Receiver)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essential information for registration (Empty value is not permitted)</td>
<td>If the received image is not provided with the checked information, an error is returned to a sender and the image is not stored.</td>
</tr>
<tr>
<td>Use additional information other than Patient ID for confirmation</td>
<td>If the patient ID of the received image has already been registered in the database, the checked information on the image is compared with the one in the database. The operation after comparison is set in next step.</td>
</tr>
</tbody>
</table>

6. Open the UID Matching window.

Select a mode and click [Next].

This selects the operation when the SOP Instance UID of the received image is already registered in the database, and all of the Additional information to be used for confirmation set in step 5 matches.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode 1</td>
<td>An error is returned to a sender, and the image is not overwritten.</td>
</tr>
<tr>
<td>Mode 2</td>
<td>The image is overwritten.</td>
</tr>
</tbody>
</table>
7 Set the Redistribution.

Specify these settings if you wish to send received images to a different server. Check the receiver to be used for sending and enter the various parameters. Images can be sent to four receivers at the same time.

Redistribution window

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Enter the IP address of the destination server.</td>
</tr>
<tr>
<td>Port No.</td>
<td>Enter a value between 1 and 65,535.</td>
</tr>
<tr>
<td>Calling AE Title</td>
<td>The Calling AE Title must be no more than 16 characters long.</td>
</tr>
<tr>
<td>Called AE Title</td>
<td>The Called AE Title must be no more than 16 characters long.</td>
</tr>
<tr>
<td>Use Redistribution Condition</td>
<td>Check this to redistribute only images containing the character string specified as the DICOM tag.</td>
</tr>
<tr>
<td>DICOM Tag</td>
<td>Click [ ] and select an item from the dropdown list.</td>
</tr>
<tr>
<td>Contents</td>
<td>Enter a character string contained in the DICOM tag. The characters ? (any single character) and * (any character string) may be used as wildcards.</td>
</tr>
</tbody>
</table>

Contents parameter

- The images are searched for character strings that match exactly the character string input for the Contents parameter.
- Inputting * only will match all received images. (This includes images for which the selected DICOM tab value is empty.)
- Inputting *? only will match images for which the DICOM tab value is not empty.

8 Add the receiver.

Click [Finish].

The receiver is added to the DICOM-Protocol Image Receiver window.
5.4.2 Deleting a DICOM-Protocol Image Receiver

1. Select the receiver to be deleted.
   Click the receiver to delete in the DICOM-Protocol Image Receiver window.

2. Delete the receiver.
   Click [Delete].
   A warning message is displayed. Click [OK].

5.4.3 Changing the DICOM-Protocol Image Receiver settings

Receivers created for Query/Retrieve do not allow their settings to be changed.

1. Select the receiver whose settings you want to change.
   Click the receiver whose settings you want to change in the DICOM-Protocol Image Receiver window.

2. Open the General window.
   Click [Property].

3. Change the receiver settings.
   Refer to 5.4.1 Adding a Receiver (→ 85P.), and change the settings.
6. Reading Images (DICOM Image File Reader)

6.1 What is the DICOM Image File Reader?

The DICOM Image File Reader has functions that can save images stored in a recording medium or on a shared network drive to an online folder or register their information to a database.

Images are read based on the settings in a previously prepared scenario. Up to four scenarios may be prepared.

This section describes the procedure for reading images and shows examples of how to create scenarios (the procedure for saving images to an online folder from a recording medium and for registering information on image data stored on a shared drive to a database).

<table>
<thead>
<tr>
<th>Description</th>
<th>Relevant chapter and page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening the DICOM Image File Reader window</td>
<td>6.2 DICOM-Image-File Reader window (→ 92P.)</td>
</tr>
<tr>
<td>Reading images</td>
<td>6.3 Reading captured images (→ 94P.)</td>
</tr>
<tr>
<td>Creating a scenario for reading images from a recording medium</td>
<td>6.4 Creating a scenario example 1 (reading from a recording medium) (→ 97P.)</td>
</tr>
<tr>
<td>Creating a scenario for reading images from a shared drive</td>
<td>6.5 Creating a scenario example 2 (reading from a shared drive) (→ 103P.)</td>
</tr>
<tr>
<td>Modifying a scenario</td>
<td>6.6 Modifying scenarios (→ 107P.)</td>
</tr>
<tr>
<td>Editing a file for replacing patient information</td>
<td>6.7.3 Editing the ccrhis.his file (→ 110P.)</td>
</tr>
</tbody>
</table>
6.2 DICOM-Image-File Reader window

6.2.1 Opening the DICOM Image File Reader window

Note: The DICOM Image File Reader can be used only by the user who has checked Archive Privilege in the Access Privilege field (→ 15P.).
The DICOM-Image-File Reader cannot be executed during execution of the Storage Administrator.

The DICOM Image File Reader window can be opened directly by clicking [DICOM Image File Reader] in the DR System Manager.

1 Open the Connection to the server window.
   Click the commands from the taskbar in the following order.
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [DICOM-Image-File Reader]

2 Enter the user name and password.
   The entered password is indicated by *.

MEMO
Be extremely careful that you do not forget your password or tell it to others.
3 Open the DICOM-Image-File Reader window.
Click [OK] in the Connection to the server window.

If the System Information window is open
The System Information window (→ 8P.) may open depending on the system settings (→ 24P.).
In this case, confirm the information displayed, and then click [OK].

6.2.2 Closing the DICOM Image File Reader window
Click [Close] in the DICOM Image File Reader window.
6.3 Reading captured images

Images are read based on the settings in the scenario. Depending on the settings, steps 3 through 5 may be required to execute the operation.

1 Select the scenario.
   Select a scenario from among Scenario 1 to Scenario 4.

2 Start the scenario.
   Click [Start].
   The Processing window opens, and the processing progress is displayed.
   (Depending on the settings, the window may be displayed after one or more of steps 3 through 5 has been performed.)
   When processing is completed, “Processing Complete... 100%” is displayed. Click [OK] to close the window.

3 Select the source folder.
   If “Select folder every time the scenario starts” is checked, the Select Source Folder window is displayed.
   Select the source folder, and then click [OK].
4. Choose to delete the database.

If “Ask to erase database every time the scenario starts” is checked, a window is displayed with the message “Do you want to delete the database?” If you select Yes, the database and all online images will be deleted. Once database is deleted it cannot be recovered. Click [Yes] to delete the database or [No] to cancel without deleting.

Note: Be careful that clicking [Yes] will delete all patient data in the database and all files (including files that are not image files) in the online folder before the scenario starts. It should be noted that database cannot be restored unless there is a backup folder.

5. Test the replacement operation.

If Replacement is set to On, a window opens displaying the warning “The test of both replacement and matching result is required for registering images on this setting. Do you want to continue?” Click [OK]. A window opens, the test is performed, and a list of results is displayed. You are ready to begin reading images if OK is displayed for all patients under Result. Click [Start]. If Failure is displayed for any patient, modify the patient information file as described in 6.7.3 Editing the ccrhis.his file (→ 110P.).
Storing modified patient information
Click [Save] to save the modified patient information as a CSV file.
The Replacement result output window appears. Specify the Save In location and File Name, and then click [OK].
6.4 Creating a scenario example 1 (reading from a recording medium)

6.4.1 Overview

This section describes how to read images from magneto-optical disks and other recording medium and then save them to an online folder without connecting the DR Image Server to the network.

The DR Image Server (DICOM Image File Reader) registers in the database information about the images on the recording medium and then saves the images to the online folder.

The DR Image Viewer is used to browse the database and to retrieve images saved in the online folder.
6.4.2 Creating a scenario (example using a recording medium)

Note: If making settings in the Select Folder, ID Matching, or SOP Instance UID Matching window, check DICOM-Protocol Image Receiver and DICOM-Image-File Reader under Setting Policy (→ 30P.).

1 Open the Select Folder window.
   In the DICOM Image File Reader window select a scenario, and then click [Scenario Wizard].

![Select Folder window](image)

2 Open the Select Folder window.
   Set parameters and click [Next].
   Be sure to always check Copy Image.

Note: Check "Ask to erase database every time the scenario starts" if you wish to rebuild the database after each time data is read.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Folder</td>
<td>Click [Browse... ] to open the Select Folder window, and select the folder or drive where image files are stored. When selecting a folder or a drive having been recorded using the DICOMDIR format, select the folder or drive where DICOMDIR files are stored.</td>
</tr>
<tr>
<td>DICOMDIR</td>
<td>Check this option when the read destination has been recorded using the DICOMDIR format.</td>
</tr>
<tr>
<td>Search sub-folder</td>
<td>If this option is checked, images in subfolders under the selected folder are also searched. When DICOMDIR is checked, Search sub-folder is unchecked, and no selection is possible.</td>
</tr>
<tr>
<td>Select folder every time the scenario starts</td>
<td>If this option is checked, the Select Source Folder window is displayed at the start of the scenario, and the source folder can be changed.</td>
</tr>
<tr>
<td>Ask to erase database every time the scenario starts</td>
<td>If this option is checked, a window is displayed for confirming deletion of the database currently being built at the start of the scenario. This parameter can be set only when editing is enabled in Setting Policy (→ 30P.).</td>
</tr>
</tbody>
</table>
3. Make the settings in the Replacement Information window.

Set parameters and click [Next].

The changes made to patient information associated with the images that have been read, based on parameters set in the Replacement Information window, are described below. For details, see 6.7 Replacing patient data (→ 108P.).

### Parameter Function

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Image</td>
<td>Be sure to check this option. If this option is checked, image will be saved to the online folder when the image is read. When this option is unchecked, the DR Image Viewer displays the image directly from the recording medium because image has not been saved in the online folder. When DICOMDIR is checked, Copy Image is unchecked, and no selection is possible.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>If On is selected, the images to be stored in the online file are compressed.</td>
</tr>
</tbody>
</table>

**Warning messages**

If Off is selected for Image Compression, a window opens and the following message is displayed:

“The compression method of this system is lossless compression. The compression can save space on disk.”

### Parameter Function

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement</td>
<td>If you select On, make the settings below.</td>
</tr>
<tr>
<td>DLL File</td>
<td>Click [Browse…], and then select the chstudi.dll file in the folder where the DR Image Server is installed.</td>
</tr>
<tr>
<td>Search Key</td>
<td>Select the Search key for the DICOM header from Patient ID or Access Number.</td>
</tr>
<tr>
<td>Replacement items</td>
<td>Click [Detail] to open the Replacement items window, and then check the item to be changed.</td>
</tr>
</tbody>
</table>
4. Set the parameters in the Backup window.

If a backup folder is already set (→ 79P.), set the parameters, and then click [Next].

```
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup File</td>
<td>When On is selected, the read images are also stored in the backup folder. If images are saved to the backup folder, the images can be viewed in the DR Image Viewer even if they are deleted from the online folder.</td>
</tr>
<tr>
<td>Backup Folder</td>
<td>The folder set in 4.3 Setting the backup folder (→ 79P.) is displayed. The backup folder cannot be changed in this window.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>When On is selected, the images stored in the backup folder are compressed.</td>
</tr>
<tr>
<td>Index Type</td>
<td>The settings made in 4.3 Setting the backup folder (→ 79P.) are displayed. The setting cannot be changed in this window.</td>
</tr>
<tr>
<td>Folder Capacity</td>
<td></td>
</tr>
</tbody>
</table>
```

**Backups**

When saving images, it is recommended that you save the entire subfolders to more than one storage medium in addition to the backup folder.

For information about backing up images to offline media, see 8. Copying Images (Image Backup Tool) (→ 119P.).
5 Make the settings in the ID Matching window.
Set parameters and click [Next].

![ID Matching window](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essential information for registration (Empty value is not permitted)</td>
<td>If the received image is not provided with the checked information, an error is returned to a sender and the image is not stored.</td>
</tr>
<tr>
<td>Use additional information other than Patient ID for confirmation (“Checked” is recommended)</td>
<td>If the patient ID of the received image has already been registered in the database, the checked information on the image is compared with the one in the database. The operation after comparison is set in step 6.</td>
</tr>
</tbody>
</table>

6 Open the UID Matching window.
Select a mode and click [Next].
This sets the operation when the SOP Instance UID of the received image is already registered in the database, and fully matched Additional information to be used for confirmation set in step 5.

![UID Matching window](image)

Continued on the following page >>
6. Reading Images (DICOM Image File Reader)

7. Make the settings in the Save Scenario window.
Set parameters.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode 1</td>
<td>An error is returned, and the image is not overwritten.</td>
</tr>
<tr>
<td>Mode 2</td>
<td>The image is overwritten.</td>
</tr>
</tbody>
</table>

8. Save the scenario.
Click [Finish].
If a scenario is already registered, the warning message is displayed.
Click [OK] to overwrite, and click [Cancel] to not save.

Registering to Startup Menu
To open the Connection to the server window when Windows is started, copy the shortcut for the DICOM-Image-File Reader in the Start menu and paste it under [Startup].
After logging in, the DICOM-Image-File Reader window is opened.
6.5 Creating a scenario example 2 (reading from a shared drive)

6.5.1 Overview

This section describes how to connect the DR Image Server to the network and read the images saved in the shared drive.

The DR Image Server (DICOM-Image-File Reader) registers the information of image data that is stored in the shared drive to the database without saving the images to the online folder. The DR Image Viewer browses the database, and then retrieves and displays images from the shared drive.

6.5.2 Creating a scenario (example using shared folder)

1. Open the Select Folder window.
   In the DICOM Image File Reader window select a scenario, and then click [Scenario Wizard].

Select Folder window
2. Open the Select Folder window.
Set parameters and click [Next]. Do NOT check Copy Image.

Note: Check “Ask to erase database every time the scenario starts” if you wish to rebuild the database after each time data is read.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Folder</td>
<td>Click [Browse...] to open the Select Folder window, and then select the shared drive.</td>
</tr>
<tr>
<td>DICOMDIR</td>
<td>Do not check this option. If it is checked, Copy Image is automatically checked, and the images will be saved to the online folder when they are read.</td>
</tr>
<tr>
<td>Search sub-folder</td>
<td>If this option is checked, images in subfolders under the selected folder are also searched.</td>
</tr>
<tr>
<td>Select folder every time the scenario starts</td>
<td>If this option is checked, the Select Source Folder window is displayed at the start of the scenario, and the source folder can be changed.</td>
</tr>
<tr>
<td>Ask to erase database every time the scenario starts</td>
<td>If this option is checked, a window is displayed for confirming deletion of the database currently being built at the start of the scenario. This parameter can be set only when Editing is enabled in Setting Policy (→ 30P.).</td>
</tr>
<tr>
<td>Copy Image</td>
<td>Do NOT check this option. Image will not be saved to the online folder when the image is read if this option is unchecked. If this option is checked, image will be saved to the online folder when the image is read.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>This setting cannot be made unless the Copy Image is checked.</td>
</tr>
</tbody>
</table>

3. Make the settings in the ID Matching window.
Set parameters and click [Next].

ID Matching window
4. Open the UID Matching window.

Select a mode and click [Next].

This sets the operation when the SOP Instance UID of the received image is already registered in the database, and fully matched Additional information to be used for confirmation set in step 3.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essential information for registration (Empty value is not permitted)</td>
<td>If the received image is not provided with the checked information, an error is returned to a sender and the image is not stored.</td>
</tr>
<tr>
<td>Use additional information other than Patient ID for confirmation (&quot;Checked&quot; is recommended)</td>
<td>If the patient ID of the received image has already been registered in the database, the checked information on the image is compared with the one in the database.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode 1</td>
<td>An error is returned, and the image is not overwritten.</td>
</tr>
<tr>
<td>Mode 2</td>
<td>The image is overwritten.</td>
</tr>
</tbody>
</table>
5. Make the settings in the Save Scenario window. Set parameters.

![Save Scenario window]

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a scenario name within 20 bytes.</td>
</tr>
<tr>
<td>Description 1</td>
<td>Settings of the created scenario are displayed.</td>
</tr>
<tr>
<td>Description 2</td>
<td>Enter detailed explanation of the created scenario.</td>
</tr>
</tbody>
</table>

6. Save the scenario.

Click [Finish].

If a scenario is already registered, the following warning message is displayed:
“A scenario has already been registered under this number. Do you wish to overwrite?” Click [OK] to overwrite, and click [Cancel] to not save.

**Registering to Startup Menu**

To open the Connection to the server window when Windows is started, copy the shortcut for the **DICOM-Image-File Reader** in the Start menu and paste it under [Startup].

After logging in, the DICOM-Image-File Reader window is opened.
6.6 Modifying scenarios

This is used to modify registered scenarios.

1. Select the scenario.
   Select the scenario to be modified from among Scenario 1 to Scenario 4 in the DICOM-Image-File Reader window.

2. Open the Select Source Folder window.
   Click [Modify].

3. Modify the scenario.
   Modify the scenario by referring to 6.4 Creating a scenario example 1 (reading from a recording medium) (→ 97P.) or 6.5 Creating a scenario example 2 (reading from a shared drive) (→ 103P.).
6.7 Replacing patient data

6.7.1 Changing patient data

To overwrite the patient information associated with images read using the DICOM Image File Reader with information from a previously prepared patient information file (ccchis.his) and register this image information in the database:

There are 11 items registered in the database by this operation: Accession Number, Patient ID, Patient Name, Sex, Birth Date, Age, Patient’s Height, Patient’s Weight, Name of Physician Reading Study, Referring Physician’s Name, and Comment (Study Description).
6.7.2 Example of using ccrhis.his file

This example shows the case when viewing the ccrhis.his file containing two patients information and modifying the information of the images.

Example 1: When setting patient ID to search key

The image 1 information is changed to the information for Mr. Michael Watson (Image 1’). On the other hand, the image 2 patient information is not changed.

The figure below shows an example when the image 1 patient information is changed.

Example 2: When setting accession number to search key

The image 2 patient information is changed to the information for Ms. Catherine Watson (Image 2’). On the other hand, the image 1 patient information is not changed.

The figure below shows an example when the image 2 patient information is changed.
6.7.3 Editing the ccrhis.his file

A file named ccrhis.his is stored in the folder containing the main DR Image Viewer System program. The file is written in CSV (Comma Separated Values) format. When it is viewed in a text editor, 16 types of parameters are written separated by commas as shown below.

```
000,0001,20011025,00001,MICHAEL WATSON,M,19751025,26,1.70,63.0,smith,thomas,comment,,0
```

Parameter List

<table>
<thead>
<tr>
<th>Order No.</th>
<th>Name</th>
<th>Value when Blank</th>
<th>DICOM Tag</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Study Status</td>
<td>000</td>
<td>Always set to 000.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Accession Number (search target)</td>
<td>Never blank</td>
<td>(0008,0050)</td>
<td>Character string up to 16 bytes</td>
</tr>
<tr>
<td>3</td>
<td>Study Date, Study Time</td>
<td>Image information cannot be overwritten.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Patient ID</td>
<td>No information</td>
<td>(0010,0020)</td>
<td>Character string up to 64 bytes</td>
</tr>
<tr>
<td>5</td>
<td>Patient Name</td>
<td>No information</td>
<td>(0010,0010)</td>
<td>Character string up to 52 bytes</td>
</tr>
<tr>
<td>6</td>
<td>Sex</td>
<td>No information</td>
<td>(0010,0040)</td>
<td>Single character of M, F, or O</td>
</tr>
<tr>
<td>7</td>
<td>Birth Date</td>
<td>No information</td>
<td>(0010,0030)</td>
<td>Numbers in YYYYMMDD format (YYYY: Year, MM: Month, DD: Day)</td>
</tr>
<tr>
<td>8</td>
<td>Age</td>
<td>No information</td>
<td>(0010,1010)</td>
<td>One of nnnY, mnnM, mnnW, mnnD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>018Y indicates 18 years old, 004D indicates 4 days after birth.</td>
</tr>
<tr>
<td>9</td>
<td>Patient’s Height</td>
<td>No information</td>
<td>(0010,1020)</td>
<td>Number to two decimal places.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Units are meters. Example: 1.60</td>
</tr>
<tr>
<td>10</td>
<td>Patient’s Weight</td>
<td>No information</td>
<td>(0010,1030)</td>
<td>Number to one decimal place.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Units are kilograms. Example: 62.5</td>
</tr>
<tr>
<td>11</td>
<td>Name of Physician Reading Study</td>
<td>No information</td>
<td>(0008,1060)</td>
<td>Character string up to 63 bytes</td>
</tr>
<tr>
<td>12</td>
<td>Referring Physician’s Name</td>
<td>No information</td>
<td>(0008,0090)</td>
<td>Character string up to 63 bytes</td>
</tr>
<tr>
<td>13</td>
<td>Comment</td>
<td>No information</td>
<td>(0008,1030)</td>
<td>Character string up to 52 bytes</td>
</tr>
<tr>
<td>14</td>
<td>Study block</td>
<td>Do not write anything here.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Text Macro Character String</td>
<td>Do not write anything here.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Number of Pieces of Exposure Information</td>
<td>0</td>
<td>Always set to 0.</td>
<td></td>
</tr>
</tbody>
</table>

Number of characters in patient ID and patient name

When the DICOM Image File Reader is used to change patient information recorded in the ccrhis.his file, the patient ID may be a maximum of 16 bytes and the patient name a maximum of 52 bytes.

In contrast, when System Administrator is used to perform batch registration or batch replacement of patient information, the patient ID may be a maximum of 64 bytes and the patient name a maximum of 52 bytes.
7. Received Image Storage and Management (Queue Management Tool)

The archive queue (images stored in the online folder or backup folder) and image distribution queue (images stored in the receiver set in the distribution list) when images are received can be managed.

7.1 Queue Management Tool window

7.1.1 Opening the Queue Management Tool window

Click [Queue Management Tool] in the DR System Manager to open the Queue Management Tool window directly.

1. Open the Connection to the server window.
   
   Click the commands from the taskbar in the following order.
   
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Queue Management Tool]

   ![Connection to the server window]

2. Enter the user name and password.
   
   The entered password is indicated by *.

   **Passwords**

   Be extremely careful that you do not forget your password or tell it to others.
3. Open the Queue Management Tool window. Click [OK] in the Connection to the server window.

If the System Information window is open
The System Information window (→ 8P.) may open depending on the system settings (→ 24P.).
In this case, confirm the information displayed, and then click [OK].

Pending Folder
When using the Queue Management Tool, it is necessary to set the pending folder to save the images deleted from the list.
If the pending folder is not set, a Folder Set window opens. Set the pending folder.

7.1.2 Closing the Queue Management Tool window
To close the Queue Management Tool window, either click [File] > [Close] from the menu bar, or click the in the top right corner of the window.
7.2 Managing the Archive Queue

The archive queue can be viewed, re-saved, or deleted.

7.2.1 Viewing the Archive Queue

You can check the archive queue status.

1 Display the archive queue status.
   Double-click the archive queue in the Item box.
   The queue status is displayed in the Status box.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Saving succeeded. (This indication disappears in a few seconds.)</td>
</tr>
<tr>
<td>Processing</td>
<td>Saving is in process.</td>
</tr>
<tr>
<td>Waiting</td>
<td>Waiting for saving.</td>
</tr>
<tr>
<td>Error</td>
<td>Error occurred during saving.</td>
</tr>
<tr>
<td>Fatal error</td>
<td>Fatal error occurred during saving.</td>
</tr>
</tbody>
</table>
2 Display detail on the queue.

Right-click the queue and then click [Property], or click the commands from the menu bar in the following order.
[Queue] > [Property]

The Detail dialog opens to show detailed information.
You can also open the dialogue by double-clicking the queue.

![Detail dialog](image)

3 Update the list.

To update the list, click the commands from the menu bar in the following order.
[View] > [Refresh]

7.2.2 Re-saving the Archive Queue

The archive queue that failed to be saved can be retried.

1 Select the queue to save again.
Click the queue in the list to save again.

2 Re-save the queue.
Right-click and then click [Retry], or click the commands from the menu bar in the following order.
[Queue] > [Retry]

![Re-saving the Archive queue](image)
7.2.3 Deleting the Archive Queue

The archive queue can be deleted from the list. Note that images are moved to the pending folder.

1. Select the queue to be deleted.
   In the list, click the queue to be deleted.

2. Delete the queue.
   Right-click and then click [Property], or click the commands from the menu bar in the following order.
   
   [Queue] > [Delete]

Deleting the Archive queue
7.3 Managing the Redistribution Queue

The redistribution queue can be viewed, re-transmitted, or deleted.

7.3.1 Viewing the Redistribution Queue

The redistribution queue status can be viewed. For details on the image distribution settings, refer to 5.4.1 Adding a Receiver (→ 85P.).

1. Display the redistribution queue status.
   
   Double-click the redistribution queue in the Item box.
   
   The queue status is displayed in the Status box.

   ![Redistribution Queue status](image)

   **Redistribution Queue status**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Transmission succeeded. (This indication disappears in a few seconds.)</td>
</tr>
<tr>
<td>Processing</td>
<td>Transmission is in process.</td>
</tr>
<tr>
<td>Waiting</td>
<td>Waiting for transmission.</td>
</tr>
<tr>
<td>Fail</td>
<td>Transmission failed.</td>
</tr>
<tr>
<td>Service Stop</td>
<td>The image distribution service is stopped. To start the service, click the commands from the menu bar in the following order. [Edit] &gt; [Distribution running] Check that the checkbox of Distribution running is checked.</td>
</tr>
</tbody>
</table>

2. Select the queue.

   Click the queue in the list to display detailed information.
3 Display detailed information about the queue.
Right-click the queue and then click [Property], or click the commands from the menu bar in the following order.
[Menu] > [Queue]
The following dialog opens to show detailed information about the queue.
You can also open the dialogue by double-clicking the queue.

4 Update the list.
To update the list, click the commands from the menu bar in the following order.
[View] > [Refresh]

7.3.2 Re-transmitting the Redistribution Queue
The redistribution queue that failed to be transmitted can be retried.

1 Select the queue to be re-transmitted.
In the list, select the queue to be re-transmitted.

2 Re-transmit the queue.
Right-click and then click [Retry], or click the commands from the menu bar in the following order.
[Queue] > [Retry]
7.3.3 Deleting the Redistribution Queue

Delete the redistribution queue from the list. Note that images are moved to the pending folder.

1. Select the queue to be deleted.
   In the list, click the queue to be deleted.

2. Delete the queue.
   Right-click and then click [Delete], or click the commands from the menu bar in the following order:
   [Queue] > [Delete]

7.3.4 Starting and Stopping the Image Distribution Service

To perform redistribution, the image distribution service must be in process.
Start and stop of the image distribution service can be set.

1. Check whether the image distribution has been started.
   Click [Edit] on the menu bar.
   If the image distribution service has been started, “Distribution running” is checked. If the service is stopped, it is not checked.

2. Change the image distribution setting.
   In the status in step 1, clicking “Distribution running” allows you to change the image distribution service setting.

Note: When using this function in a Windows Vista environment, appropriate setting is required at installation procedure.
8. Copying Images (Image Backup Tool)

Images can be copied to an offline medium automatically (automatic backup) or manually (manual backup).
When the computer starts, the Image Backup Tool (automatic backup) starts and its icon is displayed in the information area.

8.1 Backing up Images Automatically

Only folders which have reached their maximum size that has been set at Folder Capacity (→ 79P.) are copied, according to the settings.

8.1.1 Setting automatic backups

1. Open the Image Backup Tool.
   Double-click the icon in the Information area on the right of the taskbar.

Action to take when the icon is not displayed in the information area

If the icon is not displayed in the information area, click the Image Backup Tool on the DR System Manager, or click the commands from the taskbar in the following order to open the Select Mode window.

[Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Image Backup Tool]

In the Select Mode window, select Automatic Backup and click [OK].

Image Backup Tool window
2 Make settings for backup.
Set items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup folder</td>
<td>Click [Browse...] to open the Browse For Folder window and then set the backup folder.</td>
</tr>
<tr>
<td>Destination</td>
<td>Click [▼] to set the destination from the dropdown list.</td>
</tr>
</tbody>
</table>

3 Specify the schedule.
Check the days of the week on which backups are to be performed, and then click [▲] or [▼] to set the backup time.

4 Specify the number of backup copies.
Click [▲] or [▼] and set the number of copies within the range from 1 to 3.

5 Enter settings for the remaining items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete folders automatically that are backed up completely.</td>
<td>When this option is checked, the copy source folder is deleted after the backup completes.</td>
</tr>
<tr>
<td>Shutdown automatically after backing up folders.</td>
<td>When this option is checked, the computer shuts down automatically after the backup completes.</td>
</tr>
<tr>
<td>Copy rule setting</td>
<td>When this is clicked, a window opens. To allow folders to be copied to the destination in other than serial (folder number) order, check “Revoke serial copy,” and then click [OK] to close the window.</td>
</tr>
</tbody>
</table>

6 Make the settings to be effective.
To close the window after making the settings effective, click [Apply]. To close the window after making the settings ineffective, click [Close].
When the window is closed, it is displayed as an icon in the information area.
8.1.2 Running automatic backups

To back up images according to the settings:
The Copy Status window is displayed while copying is in progress.

The window closes automatically when copying finishes.
Also, if “Shutdown automatically after backing up folders” is checked, the computer automatically shuts down after copying finishes.

If capacity is low on the destination medium
If capacity on the destination medium is insufficient, the following message is displayed:
“Destination folder does not have enough space. If you continue the copy process, please change the storage media with the new one, and then click [Yes] button. If you abort the copy process, click the [No] button.”
Replace the medium and click the [Yes] button.

If you restore the study database, the backup folder will contain only numbers created up to the last restore point. As a result, some folders that should be backed up may not be copied to the backup destination. To prevent this, receive or read a new image. This will cause the database information to be updated.
8.2 Backing up Images Manually

The procedure for backing up images manually is explained below.

1. **Cancel automatic backup.**
   When the computer starts, the Image Backup Tool (Automatic Backup) starts. Right-click the icon on the right of the taskbar, and then click [Exit].

2. **Open the Image Backup Tool.**
   Click the Image Backup Tool on the DR System Manager or click the commands from the taskbar in the following order.
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Image Backup Tool]

3. **Select a mode.**
   Select Manual Backup and click [OK].

4. **Select the backup folder.**
   Click [Browse...] to open the Browse For Folder window and then set the backup folder. A subfolder list appears.

5. **Select the subfolders to be backed up.**
   Check the names of the subfolders to be backed up.

6. **Specify the destination.**
   Click to specify the destination drive.
7 Execute backup.
   Click [Execute]. The following window opens to indicate the progress of copying.

![Copy status window]

8 The backup operation is completed.
   When copy is completed, the following message appears:
   "Copying images was completed. If you copy another images continuously, please click the Continue button. If not so, please click the Exit button to terminate this program."
   Click [Exit] to terminate the program or click [Continue] to return to Step 4 to backup more images.

**Enabling Automatic Backup**
To enable Automatic Backup after Manual Backup completes, click the Image Backup tool in DR System Manager or click the commands from the taskbar in the following order.

[Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Image Backup Tool]
   The Select Mode window opens. Select Automatic Backup and click [OK].
8. Copying Images (Image Backup Tool)
9. Database Backup and Restore

If backups of the database are made, the database can be recovered to the stage where it was last saved in case a problem occurs.
Also, if the database is performing a redundant operation, it may be possible to recover the database at the stage just before the fault occurred.
It is recommended that you make backups on a regular basis.

9.1 Database Backup Tool window

9.1.1 Opening the Database Backup Tool window

To back up or restore a database, you must login with a user name having administrator privileges.

Note: When using Windows Vista, the administrator's authority is required to start the database backup tool.

1. Open the Login window.
   Click the commands from the taskbar in the following order.
   [Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Database Backup Tool]
   The check of the database is started. When the check is completed, the Login window is displayed.

   ![Login window](image)

   Login window

   Opening the Database Backup Tool window from the DR System Manager
   Click Database Backup Tool in the DR System Manager to open the Database Backup Tool window directly.

2. Enter the user name and password.
   The entered password is indicated by “*”.

   Passwords
   Be extremely careful that you do not forget your password or tell it to others.
3  Open the Database Backup Tool window.
   Click [OK] in the Login window.

9.1.2 Closing the Database Backup Tool window
   Click [Close] to close the Database Backup Tool window.
9.2 Backing up a database

1. Select the database to back up.
   In the Database Backup window, select [DRS Database] or [Log Database].

2. Open the Backup window.
   Click the icon in the Backup column.

3. Select the folder where the file will be saved.
   Click [Browse...] to open the Browse Folder window, and then select the folder where the database will be backed up.

   **Name of backup file**
   After the Browse Folder window is closed, the destination folder name and backup file name are displayed under Destination.
   The name of the backup file is set automatically as follows.
   Study database: drs-date-time.dat
   Log database: logdb-date-time.dat

4. Start the backup operation.
   Click [OK]. The following message is displayed in the window:
   “Backup speed depends on database size and data transfer speed. It may take only a few minutes or over an hour. Timeout is 90 minutes. Do you want to start the backup?” Click [OK].

   **Timeout**
   If the backup does not complete within 90 minutes after start, an error occurs and no backup file is created.
The backup operation is completed.

The following message is displayed if the backup operation is successful:

“The backup is completed. It is recommended to have the backup data copied and saved in a media other than the hard disk, such as CD-R and DVD.”

Click [OK].
9.3 Restoring a database

This section describes how to restore a corrupted or other database to its original state using the backup database made in 9.2 Backing up a database (√ 127P.).

1. Open the Restore window.
   Click the icon in the Restore column in the Database Backup Tool window.

   ![Restore window]
   The latest backup information is displayed below the latest backup file.

2. Select the folder where the file is saved.
   Click [Browse...] to open the Open window, and then select the backup file.

   ![File information display]
   When a backup file is selected, information about the file is displayed.

3. Start the restore operation.
   Click [OK].
   An window opens and “Information registered after the file was backed up may be lost if the backup data file is restored. Do you want to continue?” appears, click [Yes].

   ![Continued on the following page >>]
4. The restore operation is completed.
   If the restore operation is successful, the window opens and displays
   “Restoration is completed”. Click [OK].

Backups after restoration
Once a restoration is completed, be sure to always make a backup before recording the
database immediately after restoration.
When you continue with operation without making a backup, and then a fault
subsequently occurs, you will be unable to restore the database to the point just before
the fault.
10. DICOM Query/Retrieve Setting

Note: A license is required to use DICOM Query/Retrieve. For how to purchase the license, contact the distributor or Canon representative from which you purchased this software.

The DICOM Query/Retrieve is the function for querying (getting) the patient information, study information, and series information from the DR image viewer and retrieving the conforming image. Settings necessary for using the DICOM Query/Retrieve are explained below.

1 Open the QR Setting window.
Click the commands from the taskbar in the following order.
[Start] > [All Programs] > [Canon Medical] > [DR Image Server] > [Query/Retrieve Tool]

2 Set items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query/Retrieve SCP</td>
<td>IP Address Enter the IP address of the server.</td>
</tr>
<tr>
<td>Query Setting</td>
<td>SCP AE title Enter the AE title of the server in 16 characters or less.</td>
</tr>
<tr>
<td></td>
<td>SCU AE title Enter the AE title of the DR image viewer in 16 characters or less.</td>
</tr>
<tr>
<td></td>
<td>Query Port Number Enter the port number.</td>
</tr>
</tbody>
</table>
### 10. DICOM Query/Retrieve Setting

#### Display the option settings.

To set optional functions, click [OK] while pressing the Shift key on the keyboard.

![QR setting window (Option setting)](image)

#### Set optional function items.

Enter the option settings, and then click [OK] to close the window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only the patient registered into the DRS DB is displayed.</td>
<td>When this is checked, the patient information not registered in the DR image viewer system database is not displayed.</td>
</tr>
<tr>
<td>When 31 or more patients are queried, an error occurs.</td>
<td>When this is checked, an error message appears if 31 or more patients information matches the search conditions.</td>
</tr>
<tr>
<td>Study registered into the DRS DB is not displayed.</td>
<td>When this is checked, the studies registered in the DR image viewer system database are not displayed.</td>
</tr>
<tr>
<td>Modality series registered into the DRS DB are not displayed.</td>
<td>When this is checked, the series registered in the DR image viewer system database are not displayed.</td>
</tr>
</tbody>
</table>
10. DICOM Query/Retrieve Setting

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images of series except for CR, DX, and SC are not displayed.</td>
<td>When this is checked, information about the images whose modality value is other than CR, DX, and SC is not displayed. The DR image viewer system does not assure normal display of the images whose modality value is other than CR, DX, and SC.</td>
</tr>
<tr>
<td>Use caret (^:5EH) code instead of space code in patient name.</td>
<td>When this is checked, caret code (^:5EH) is used.</td>
</tr>
</tbody>
</table>

5

Allow the settings to take effect.

Click [OK] to close the QR setting window.
11. Error Messages

An error message will be displayed when some sort of fault occur.
Check the error message, and then perform the appropriate remedy.

Example of Error Message

11.1 Errors

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master database may be broken.</td>
<td>This is due to a system incompatibility.</td>
<td>Contact the distributor where you purchased this product or Canon representative.</td>
</tr>
<tr>
<td>You do not have administrative privileges.</td>
<td>You logged in with a user name not having administrative privileges when using an option requiring administrative privileges.</td>
<td>Login with a user name that gives administrative privileges.</td>
</tr>
<tr>
<td>Start up System Manager in general user mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On-line folder cannot be changed because it has already been used.</td>
<td>You tried to change the online folder where images are saved with the Storage Administrator.</td>
<td>The folder cannot be changed if it contains saved images.</td>
</tr>
<tr>
<td>Remaining free space is empty. Reading will be terminated.</td>
<td>The remaining space on the disk has reached the lowest left space that was set by the Storage Administrator.</td>
<td>Either decrease the “Lowest Left space”, or delete some images.</td>
</tr>
<tr>
<td>There are some programs connecting database.</td>
<td>There is a program that is using the database when an attempt is made to execute restoration using Database Backup Tool.</td>
<td>Terminate the specified program or reboot the program.</td>
</tr>
<tr>
<td>Please restore the database, after restarting this computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>There are some programs connecting database.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Please restore the database, after terminating below programs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close Storage Administrator window before starting DICOM-Protocol Image Receiver.</td>
<td>You tried to receive DICOM protocol images while making the settings in the Storage Administrator.</td>
<td>Close the Storage Administrator.</td>
</tr>
<tr>
<td>Close Storage Administrator window before starting DICOM-Image-File Reader.</td>
<td>You tried to run the DICOM-Image-File Reader during setting of the Storage Administrator.</td>
<td>Close the Storage Administrator.</td>
</tr>
</tbody>
</table>
## 11.2 Warnings

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Link Failure!</td>
<td>The system cannot connect to the database.</td>
<td>Check if the SQL Server service is started.</td>
</tr>
<tr>
<td>User authentication fails!</td>
<td>The entered user name or password at login was not correct.</td>
<td>Enter the correct user name and password.</td>
</tr>
<tr>
<td>The threshold must be some integer between 1 and 1000.</td>
<td>No value was entered for lowest left space when the settings were made for the Storage Administrator.</td>
<td>Enter a value for the “Lowest Left space”.</td>
</tr>
<tr>
<td>On-line folder is inaccessible. Check on-line folder or network.</td>
<td>The system cannot access the online folder.</td>
<td>Check if online folder sharing and access privileges have been set correctly.</td>
</tr>
<tr>
<td>Failed to register database. Try again.</td>
<td>The system failed in registering the settings.</td>
<td>Try again.</td>
</tr>
<tr>
<td>Selected receiver will be deleted. Images being transferred or waiting to be transferred may not be able to be received. Are you sure you wish to continue?</td>
<td>You tried to delete a receiver.</td>
<td>To delete the database, click [OK]. To not delete, click [Cancel].</td>
</tr>
<tr>
<td>Closing DICOM-Protocol Image Receiver window will stop all the image receivers.</td>
<td>You tried to close the DICOM-Protocol Image Receiver window.</td>
<td>Make sure that it is OK to close all the receivers before closing the window.</td>
</tr>
<tr>
<td>Enter receiver name.</td>
<td>You tried to set another tab without entering the receiver name.</td>
<td>Enter the receiver name.</td>
</tr>
<tr>
<td>Enter receiver AE title.</td>
<td>You tried to set another tab without entering the receiver AE title.</td>
<td>Enter the receiver AE title.</td>
</tr>
<tr>
<td>Back slash mark “\” and square bracket “[ ]” cannot be used in receiver name.</td>
<td>You entered a back slash mark “\” or square bracket “[ ]” in the receiver name.</td>
<td>Do not use a back slash mark “\” or square bracket “[ ]” in the receiver name.</td>
</tr>
<tr>
<td>Receiver name has already been used. Enter a different name.</td>
<td>The receiver name has already been used.</td>
<td>Change the receiver name.</td>
</tr>
<tr>
<td>Port number must be between 1 and 65535.</td>
<td>Either a port number was not entered, or 0 was entered.</td>
<td>Enter the number between 1 and 65535.</td>
</tr>
<tr>
<td>Port number has already been used. Enter a different number.</td>
<td>The port number is already used by other receiver.</td>
<td>Set a port number that has not been used.</td>
</tr>
<tr>
<td>The compression method of this system is lossless compression. The compression can save space on disk.</td>
<td>You selected Off under Image Compression.</td>
<td>The compression can save space on disk.</td>
</tr>
<tr>
<td>Message</td>
<td>Cause</td>
<td>Remedy</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The capacity number must be some integer between 100 and 20000 do you</td>
<td>You entered a value outside the 100 to 20,000 range for the folder</td>
<td>Enter a value in the range of 100 to 20,000.</td>
</tr>
<tr>
<td>want to set it again?</td>
<td>Capacity.</td>
<td></td>
</tr>
<tr>
<td>Do you want to delete the database? If you select Yes, the database</td>
<td>In the scenario of the DICOM-Image-File Reader, Ask to erase database</td>
<td>To delete the database, click [OK]. To not delete, click [Cancel].</td>
</tr>
<tr>
<td>and all online images will be deleted. Once database is deleted it cannot</td>
<td>every time scenario starts is checked.</td>
<td></td>
</tr>
<tr>
<td>be recovered.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Failed to delete database.</td>
<td>The system cannot connect to the database.</td>
<td>Reboot the computer, and then try again.</td>
</tr>
<tr>
<td>If image file is not copied to the database, you may not be able to</td>
<td>An unshared folder was selected for the image reading folder, and</td>
<td>If you will enable sharing later, click [OK]. To enable sharing</td>
</tr>
<tr>
<td>access to the file depending on setting for access permission of share</td>
<td>Copy Image is checked.</td>
<td>immediately, click [Cancel], and then set the folder.</td>
</tr>
<tr>
<td>folder. You need to register share folder in order to access the</td>
<td></td>
<td></td>
</tr>
<tr>
<td>source folder from viewer on network.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No images in image source folder.</td>
<td>There are no images in the folder set as the image reading folder.</td>
<td>Either copy images to the image reading folder, or change the image</td>
</tr>
<tr>
<td>Failed to load HIS dll file.</td>
<td></td>
<td>reading folder.</td>
</tr>
<tr>
<td>Select an image source folder.</td>
<td>The system was unable to read the selected DLL file.</td>
<td>Check the patient data replacement settings.</td>
</tr>
<tr>
<td>Select a DLL file.</td>
<td>You tried to set another tab without selecting the image reading</td>
<td>Set the image reading folder.</td>
</tr>
<tr>
<td>Ampersand mark “&amp;” cannot be used in scenario name.</td>
<td>Even though the Replacement was set to On in the Fill in Information</td>
<td>Select the DLL file.</td>
</tr>
<tr>
<td>A scenario has already been registered under this number. Do you wish</td>
<td>You entered an ampersand mark “&amp;” in the scenario name.</td>
<td>Do not use an ampersand mark “&amp;” in the scenario name.</td>
</tr>
<tr>
<td>to overwrite?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>There is the error information in System Information.</td>
<td>The database has not been backed up, the archive queue or</td>
<td>Confirm the cause of the error by observing the System Information</td>
</tr>
<tr>
<td>Please see error information and cope with it.</td>
<td>redistribution queue is erroneous, or the remaining folder space is</td>
<td>window and then take an appropriate action.</td>
</tr>
<tr>
<td></td>
<td>insufficient.</td>
<td></td>
</tr>
</tbody>
</table>
### 11. Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need to register and start the archive service firstly!</td>
<td>An attempt was made to read an image using the DICOM Image File Reader before starting the archive service.</td>
<td>Reboot the computer or reinstall DR Image Server.</td>
</tr>
</tbody>
</table>
Index

A
- Access Privilege 15
- Administrator Privilege 15
- Archive Privilege 15
- Archive Queue 113
- Auto Logout 10, 25
- Automatic Backup 119, 122

B
- Backup 87, 100
- Backup folder 79, 87, 100
- Browse Shared Folder window 73

C
- Calling AE Title 86
- Computer Management 19
- Computer Name 19
- Connection to the server window 7
- Copy Image 99, 104

D
- Data Access Log 62, 67
- Data replacement 47
- Database Backup Tool 6
- Database Backup Tool window 126
- Deleting Online Files 57
- DICOM Image File Reader 5, 91
- DICOM-Protocol Image Receiver 5
- DR Image Server 1
- DR Image Viewer 1, 9
- DR Image Viewer System 1
- DR System Manager 4

F
- Folder Capacity 79, 87, 100
- Full Name 15

I
- ID Matching window 87, 101
- Image Backup Tool 6, 119
- Image Compression 87, 99, 100, 104
- Index Type 79, 87, 100

L
- License management 33
- Log database 127
- Log Reference 60

N
- Name 102, 106
- New Password 15

O
- Object Save 25
- Online folder 73

P
- Parameters 86
- Password 15, 66
- Patient data registration 40
- Pending Folder 112
- Port Number 86

Q
- Query/Retrieve 131
- Queue Management Tool 6, 111

R
- Receiver 85
- Receiver AE Title 86
- Redistribution Queue 116
- Redistribution window 89
- Replacement Information window 99
- Reporting Privilege 15
- Retype the New Password 15

S
- Scenario Wizard 98
- Service Name 85
- Session Log 60
- Setting policy 30
- Setting the group ID 27
- Source Folder 98, 104
- Startup Type 85
- State Start 85
- Storage Administrator 5, 71
- Storage Administrator window 72
- System Administrator 4, 11
- System Information 25
- System Information window 8
- System Setting 24

U
- UID Matching window 88, 101, 105
- Usage Privilege 15, 20
- User Management 14
- User Name 15
Index

V

Viewer Operation Privilege 20
Viewer Privilege 15